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Introducing RocPlane 

About RocPlane 
ROCPLANE is a simple to use, interactive software tool for assessing the stability of planar 
sliding blocks / wedges in rock slopes. It also allows users to estimate the support capacity 
required to achieve a specified factor of safety.  
 
A planar wedge is a wedge for which sliding occurs on a plane approximately parallel to the 
face of a slope. ROCPLANE analyzes a slice of unit thickness taken perpendicular to the 
strike of the slope face. In the program, users have the option of performing either 
DETERMINISTIC or PROBABILISTIC analyses.  
 
In a DETERMINISTIC analysis, ROCPLANE calculates the Factor of Safety for a wedge of 
known orientation and other input parameters. For PROBABILISTIC analysis the program 
allows users to specify statistical distributions for various input parameters, and the number 
of simulations required. ROCPLANE then computes the Probability of Failure of the wedge 
by running the analysis the specified number of times, each time generating different values 
for the stochastic input parameters. 
 
Other important features in ROCPLANE analysis include: 
 

• Water Pressure  
• External and seismic forces 
• Active or passive bolt support 

 
The theory and equations of planar rock slope stability analysis upon which ROCPLANE is 
based can be found in References 1 - 6. The equations used in the ROCPLANE analysis can 
also be found in the ROCPLANE Theory manual, which you should find in your ROCPLANE 
installation folder. The ROCPLANE Theory manual can also be downloaded from 
www.rocscience.com.  
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A Typical RocPlane Analysis 
Creating a Model 

To create a new planar wedge model, select the "New File" toolbar button or File →→→→ New 
from the menu. This will create a default wedge model. You can also open an existing project 
from file by selecting File →→→→ Open from the menu. ROCPLANE files have a .pln filename 
extension. 
 
Project Settings 

Select Analysis →→→→ Project Settings from the menu or the "Project Settings" toolbar button. 
The Project Settings dialog, which comes up, allows you to change the Project Title, Unit 
System, Analysis Type (Deterministic or Probabilistic). See Project Settings for more details. 
 
Entering Model Parameters 

To enter model parameters, select the "Input Data" toolbar button or Analysis →→→→ Input 
Data from the menu. This opens the Input Data dialog. This dialog allows you to define 
model parameters such as slope angle, slope height, failure plane angle, upper face angle, 
etc.  
 
Viewing the Results 
For a DETERMINISTIC analysis, the factor of safety computed for a sliding block is 
displayed on the toolbar. For a PROBABILISTIC analysis the probability of failure is 
displayed. Detailed information on analysis results and input parameters can be found in the 
Info Viewer option, available in the toolbar or the Analysis menu. 
 
Adding Support 
The factor of safety or the stability of a sliding block / wedge can be increased by adding bolt 
support. To add support, select the "Add Bolt" button on the toolbar or Support →→→→ Add Bolt 
from the menu. Next click on a point on the sliding block (in either the TOP, FRONT or SIDE 
view) where you want the bolt placed. The Bolt Properties dialog opens up from which you 
can specify the parameters of the bolt. (See the Adding a Bolt topic for more information.) 
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Program Assumptions 
ROCPLANE assumes the following geometrical conditions: 
 

• A sliding or failure plane that strikes parallel or approximately parallel (within 20 
degrees) to the face of the slope. 

• The failure plane daylights into the face of the slope. This condition occurs when the 
failure surface dips at angle shallower than the slope face. 

• The presence of release surfaces at the lateral boundaries of the slide block that have 
insignificant resistance to sliding. 

 

  
Typical planar geometry of a ROCPLANE model. Basic terminology used in the program is also 
shown on the figure. 

 

 



 

 6 

  

The release surfaces of a sliding block. 

 

In ROCPLANE, the slope slice analyzed is taken perpendicular to the face of the slope, and is 
assumed to have unit thickness.  
 

  
 
ROCPLANE performs the limit equilibrium analysis of a sliding block. The factor of safety of 
the slope or sliding mass is defined as the ratio of the total forces resisting down-slope sliding 
to the total forces inducing sliding. The resisting forces comprise the shear strength of the 
sliding surface, artificial reinforcement of the slope or other stabilizing external forces, if 
present. The driving forces consist of the down-slope component of the weight of the sliding 
block, forces generated by seismic acceleration, forces due to water pressures acting on 
various faces of the block, and external forces on the upper slope surface.  
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The limit equilibrium model in ROCPLANE assumes that all forces operating on a sliding 
block act through the centroid of the block; it ignores overturning moments. When an 
analysis involves a tension crack, it is assumed that the tension crack, just as the failure 
plane, strikes parallel to the slope face. 
 
Whereas many planar wedge analysis programs consider only vertical tension cracks, 
ROCPLANE allows for non-vertical tension cracks as well. Non-vertical tension cracks in 
ROCPLANE can have angles of inclination from the horizontal that are greater or less than 
90 degrees. 
 

Internet Update Feature 
The following features are available in the Help menu, which allow you to make sure you 
always have the latest version of the RocPlane program. 
 
Check for RocPlane Updates 

From the RocPlane menu, select Help → Product Updates → Check for RocPlane 
Updates. This will connect you to the Rocscience website, and will determine if you have the 
latest version of the program. If not, you will be able to download the latest version for free, if 
it is a minor program upgrade (ie. bug fixes) 
 
Check for Rocscience Updates 
To check for the latest versions of ALL Rocscience software that you have installed on your 
computer, select Help → Product Updates → Check for Rocscience Updates. 
 
Check for Updates Automatically 
By default, each time you start RocPlane, the program will attempt to connect to the 
Rocscience website, in order to check for the latest version of the program.  
 
To turn this feature OFF, select Help → Product Updates and DE-SELECT the Check for 
Updates Automatically checkbox. You may want to turn this feature off, if you are seeing a 
"Connect To" dialog when you start the program, and you do not wish to connect to the 
internet, or check for an update (eg. if you are using a laptop not connected to the internet, or 
you have a slow internet connection). 
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File 

Starting a New File 
To create a new ROCPLANE model, select the "New File"  toolbar button, or select File →→→→ 
New from the menu.  
 
A planar wedge model with four different views – TOP, FRONT, SIDE and PERSPECTIVE – 
will immediately appear on the screen (this view is known as the Wedge View). This new 
wedge is created using default input data in the program. You can then replace the default 
values with your own input data, through the Input Data dialog. 
 
ROCPLANE files have a .pln filename extension. 
 

Opening a File 
ROCPLANE files have a filename extension of .pln.  
 
To open an existing ROCPLANE file, click on the "Open" toolbar button, or select File →→→→ 
Open from the menu.  
 
Whenever a ROCPLANE file is opened it is automatically executed using the data found in 
the file.  
 

• If the Analysis Type in the file was set to DETERMINISTIC (Analysis Type = 
DETERMINISTIC), you will not notice the analysis since the calculation is 
instantaneous. 

• If the Analysis Type is PROBABILISTIC (Analysis Type = PROBABILISTIC), it may 
take a few seconds to complete the analysis, depending on the Number of Samples. The 
progress of the analysis is indicated in the status bar. 

 
Running the analysis each time a file is opened ensures that results can be immediately 
viewed. The user does not need to select Compute unless the Input Data is changed. 
 

Saving a File 
ROCPLANE files have a filename extension of .pln. To save a file at any time, click on the 
"Save"  toolbar button, or select File →→→→ Save from the menu.  
 
Only Input Data is saved in a ROCPLANE file; analysis results are NOT saved to a file. 
There is no need to save results since an analysis is automatically performed whenever a file 
is opened. 



 

 9

 
It should be noted, however, that: 

• The Info Viewer provides a formatted summary of analysis results and input data, 
which can be copied to the clipboard or saved to a document. 

• For a Probabilistic analysis, it is possible to export any or all of the analysis data to the 
clipboard, a text file, or Microsoft Excel, using the Export Dataset option in the 
Statistics menu. 

 

Exporting Images 
Various options are available for exporting image files in ROCPLANE. 
 
Export Image File 
The Export Image File option in the File menu allows the user to save the active view 
directly to one of two image file formats: 
 

• JPEG (*.jpg) 
• Windows Bitmap (*.bmp) 

 
Copy to Clipboard 
The active view can also be copied to the Windows clipboard using the Copy to Clipboard 
option in the Edit menu. From the clipboard, images can be pasted directly into word or 
image processing applications. See the Copy to Clipboard topic for details. 
 
NOTE: 

• To capture the entire screen to the Windows clipboard, you can use the Print Screen key 
on your keyboard. This is useful if you wish to capture multiple views in a single image, 
for example after tiling the views. 

• Pressing the Alt + Print Screen keys together will capture the application window only 
to the clipboard (useful if the ROCPLANE program window is not maximized on your 
desktop). 

 
Black and White Images (Grayscale) 
The Grayscale option in the toolbar, the View menu or the right-click menu, automatically 
converts ALL VIEWS of the current document to Grayscale, suitable for black and white 
image requirements. This is useful when sending images to a black and white printer, or for 
capturing black and white image files. The Grayscale option works as a toggle, and all 
previous colour settings will be restored when Grayscale is toggled off. 
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Print 
To print the active view, click on the "Print" toolbar button, or select File →→→→ Print from the 
menu. 
 
When printing the 3D Wedge view, only the active view within the 3D Wedge View is printed. 
 

1. The "active" view is indicated by the highlighted name of the view (Perspective, Top, 
Front, Side) in the lower left corner of the view. 

2. To make a view active, click EITHER mouse button in the view. 
3. On the Wedge View printout, the document name, job title, view name and Safety 

Factor or Probability of Failure will also appear. 
 
When printing other views in ROCPLANE (e.g. Histograms, Scatter Plots, etc.), the entire 
contents of the view will be sent to the printer. When printing the Info Viewer listing, the 
entire listing will be printed. 
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Edit 

Copy to Clipboard 
The Copy to Clipboard option in the Edit menu or the toolbar, allows you to copy the 
contents of the active view to the Windows clipboard. This can then be pasted directly into 
word or image processing applications. 
 
NOTE:  

• If the 3D Wedge View is the active view, only the active view WITHIN the Wedge view 
(Top, Front, Side or Perspective) will be copied to the clipboard. You must first click the 
mouse in the desired view (Top, Front, Side or Perspective) to make it the active view. 

 
• If you wish to copy the entire Wedge View (ie. all four views within the Wedge View) to 

the clipboard, you will have to capture the entire application window. To do this, you 
can use the Print Screen or Alt + Print Screen keys on your keyboard. See the Exporting 
Images topic for details. 

 
• If the Info Viewer is the active view, then the Copy option will copy the Info Viewer 

text to the clipboard. By default, ALL text in the Info Viewer will be copied to the 
clipboard. If you only want selected text, then first highlight the desired text with the 
mouse, and then select Copy. 

 
The Copy to Clipboard option is also available in the right-click menu on all views, except 
the 3D Wedge View. 
 

Copy Data to Clipboard 
The Copy Data to Clipboard option is available in the Edit menu, or by right-clicking on a 
Histogram, Cumulative, Scatter or Sensitivity Plot. 
 
Copy Data to Clipboard will copy the raw data used to generate a plot to the Windows 
Clipboard. For Histograms and Cumulative Distributions, the data is automatically sorted 
(lowest to highest) before it is placed on the Clipboard. It can then be pasted into a 
spreadsheet program (Excel, for example), for further processing by the user. 
 
Also note the following options: 

• With the Export Dataset option in the Statistics menu, any or all data from a 
Probabilistic Analysis can be copied to the clipboard, saved to a file, or exported to Excel 

• The Chart In Excel option allows the user to export data and automatically create a 
graph in Microsoft Excel, with a single mouse click. 
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View 

3D Wedge View 
In the 3D Wedge View, the wedge model is displayed in a four-view, split screen format 
showing: 
 

• TOP 
• FRONT 
• SIDE and 
• PERSPECTIVE  

 
views of the planar wedge. The Top, Front and Side views are orthogonal, i.e. 90 degrees with 
respect to each other. 
 
The user can perform the following actions on a wedge in the 3D Wedge View: 
 

• Rotate the model in the Perspective View  
• Move the wedge out of the slope  
• Resize or maximize the views  
• Zoom in or out of the model  
• Change the display options  
• Select an active view  

 
NOTE: the 3D Wedge View can always be accessed by selecting the 3D View option from the 
Analysis menu or the toolbar. This is useful if you have multiple views open, or if you have 
closed the 3D View, it will be re-opened when you select the 3D View option. 

 



 

 13

Coordinates 
Although a ROCPLANE model is not defined using absolute coordinates, a coordinate system 
is in effect for the TOP, FRONT and SIDE views of the model, within the 3D Wedge View. 
When the cursor is moved within the TOP, FRONT or SIDE views, coordinates, 
corresponding to the cursor location within the view, are displayed in the Status Bar in the 
lower right corner of the application window.  
 
NOTE:  

• The units of the coordinate system correspond to the system of units selected in the 
Project Settings dialog (i.e. meters or feet). 

• The origin (0, 0, 0) of the coordinate system is defined as the mid-point of the 
lowermost edge of the wedge on the slope face (i.e. the midpoint of the intersection line 
of the slope face and the failure plane).  

• Axes can be displayed in the TOP, FRONT and SIDE views with the Axes option in the 
View menu. 

• Coordinates are NOT available in the Perspective view. 
 

Rotating the Model 
In the Perspective view in ROCPLANE, the user can rotate a model for viewing from 
different angles with the LEFT mouse button. To do so: 
 

1. Press and HOLD the LEFT mouse button anywhere in the Perspective view. Notice 
that the cursor changes to a "circular arrow" symbol to indicate that you may rotate the 
model. 

2. Keep the LEFT mouse button pressed, and move the cursor around. The model is 
rotated according to the direction of movement of the cursor. 

3. To exit the rotation mode, release the LEFT mouse button. Notice that the cursor 
reverts to the normal arrow cursor. 

4. Repeat the above steps to rotate the model for viewing at other angles. 
 
NOTE: 

• The wedge can also be moved out of the slope. In combination with rotation, this 
feature allows you complete flexibility in viewing the slope and wedge from all possible 
angles. 

• Rotating the model only affects the Perspective view, while moving the wedge out of 
the slope affects all views (Top, Front, Side and Perspective). 
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Moving the Wedge 
In the 3D Wedge View, the wedge can be moved out of the slope with the RIGHT mouse 
button in any of the four views (Top, Front, Side or Perspective). To do so: 
 

1. Press and HOLD the RIGHT mouse button anywhere in ANY of the four views. Notice 
that the cursor changes to an "up-down arrow" symbol.  

2. Keeping the RIGHT mouse button pressed, move the cursor UP or DOWN. The wedge 
will slide UP or DOWN out of the slope. Note: 

• If your model does NOT have a Tension Crack, then the wedge will slide UP or 
DOWN along the failure plane. 

• If your model DOES have a Tension Crack, then the wedge will slide DOWN along 
the failure plane, and UP along the plane of the Tension Crack. 

3. To exit this mode, release the RIGHT mouse button. Notice that the cursor reverts to 
the normal arrow cursor. 

 
TIP – If you have a mouse with a mouse wheel, rotating the mouse wheel will also move the 
wedge. You may find this more convenient than using the right mouse button. 
 
Resetting the Wedge 
To reset the wedge to its normal (default) position, click and RELEASE the RIGHT mouse 
button in any of the four views. The wedge will snap back to its normal position. 
 

Resizing the Views 
In the 3D Wedge View, you can change the relative sizes of the Top, Front, Side and 
Perspective views in a number of ways: 
 

1. Double-clicking the LEFT mouse button in any view will maximize that view. Double-
clicking again in the maximized view will restore the four-view display. 

2. Alternatively, you can hover the cursor over the vertical or horizontal dividers between 
the views, or over the intersection point of the four views. The cursor will change to a 
"parallel line" or "four arrow" symbol. Press and HOLD the LEFT mouse button, and 
drag to re-size the views.  

3. Maximizing views can also be accomplished with the View →→→→ Layout options. To reset 
the four views to equal size, select View →→→→ Layout →→→→ All Views. 
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Zooming 
Zooming in the 3D Wedge View can be done in a variety of ways: 
 

1. All four views (Top / Front / Side / Perspective) can be zoomed into or out of at once by 
selecting the desired view scale (from 50% to 800%) from the View →→→→ Zoom menu. 

 
2. Individual views can be zoomed in or out independently of each other, using: 

• The Zoom buttons in the toolbar 
• The + or – numeric keypad keys 
• The Page Up / Page Down keys 
• The F2 (Zoom All), F4 (Zoom Out) or F5 (Zoom In) function keys 

 
NOTE: 
If you wish to zoom a particular view, you must first click in the view with EITHER mouse 
button to make it the active view. (When a view is active, you will notice that the name in the 
lower left corner of the view – Top, Front, Side or Perspective – is highlighted). 
 

Layout 
The Layout option in the View menu allows the user to maximize any one of the four views, 
or to reset the four-view display with the Layout →→→→ All Views option.  
 
This can be also achieved by double-clicking with the LEFT mouse button in the desired 
view. See the Resizing the Views topic for more information. 
 

Reset Wedge 
The Reset Wedge option in the View menu performs three functions: 
 

1. If the wedge has been moved out of the slope, Reset Wedge will reset the wedge back 
to its normal position in the slope. (This can also be achieved by a single RIGHT click 
of the mouse in any of the four views). 

 
2. After a Probabilistic analysis, you may wish to view wedges OTHER THAN the mean 

wedge (see the Viewing Other Wedges topic for details). If you were previously viewing 
a non-mean wedge, the Reset Wedge option will re-display the mean wedge. 

 
3. Reset Wedge also resets all zooming, so that the model is displayed at its default size. 
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Display Options 
Display Options is available in the View menu and in the toolbar. It allows the user to 
change display options in both the 3D and 2D Wedge Views.  
 

• The latest changes the user makes in the Display Options dialog automatically 
become the new program defaults. To restore the original program defaults select the 
Defaults button in the Display Options dialog. 

 
NOTE:  

• In the 3D Wedge View display options, the Selection colour refers to the colour of 
selected bolts while using the Delete Bolt and Edit Bolt options. 

• ALL Force arrows represent only the DIRECTION of a given force. Arrow sizes are 
NOT scaled for magnitude; they only represent the presence and direction of a given 
force. 

• Display Options is also available in the right-click menu on the 2D Wedge View. 
 

Grayscale 
The Grayscale option, in the toolbar or the View menu, is a toggle that automatically 
converts ALL VIEWS of the current document from colour to grayscale, or vice versa. When 
toggled on the Grayscale option is useful for sending images to a black and white printer, or 
for capturing black and white image files. When toggled off, the Grayscale option restores 
all previous colour settings. 
 

Axes 
The Axes option in the View menu, or the toolbar, can be used to toggle on or off the display 
of coordinate axes in the TOP, FRONT and SIDE views of the model, within the 3D Wedge 
View.  
 
In the 2D Wedge View, the Axes option will toggle the display of the "ruler" at the left and 
bottom edges of the view. 
 
NOTE:  

• The units of the axes correspond to the system of units selected in the Project Settings 
dialog (i.e. either meters or feet). 

• The origin (0, 0, 0) of the coordinate system is defined as the mid-point of the 
lowermost edge of the wedge on the slope face (i.e. the midpoint of the intersection line 
of the slope face and the failure plane). 

 
Although a ROCPLANE model is not defined using absolute coordinates, the display of axes 
can help the user to estimate the dimensions of the wedge from various viewing angles. 
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Active View 
In the 3D Wedge View, you will notice that when you click the mouse (either left or right 
button) in one of the four panes of the Wedge View (Perspective, Top, Front, Side), the name 
of the pane, in the lower left corner, becomes highlighted. This is an indication that the 
selected view has become the "active" pane. The active pane within the Wedge View serves 
the following purposes: 
 

1. When printing the 3D Wedge View, only the active pane is printed. 
2. When zooming with the keyboard shortcut keys (Page Up / Page Down, + / – numeric 

keys, F4 / F5 function keys), or the zoom options in the toolbar, only the active pane is 
zoomed. This allows each pane to be zoomed independently. 

3. When using the Export Image File option, only the active pane is saved to a file. 
4. When using the Copy option, only the active pane is copied to the clipboard. 

 

Chart View Options 
Markers 
The Markers option displays interval markers on: 
 

• Cumulative Distribution plots 
• Histogram Plots, if the Input Distribution or Best Fit Distribution is displayed on the 

plot. 
• Sensitivity Plots  

 
The Markers option is available in: 

• the View menu 
• the right-click menu on Cumulative, Histogram or Sensitivity plots. 

 

3D Histogram 
A Histogram plot can be displayed with a "three-dimensional" effect, by selecting 3D 
Histogram from the View menu, or by right-clicking on a Histogram and selecting 3D 
Histogram. 
 
NOTE: 

• When 3D Histogram has been applied, you can change the "viewing angle" of the 3D 
Histogram, by clicking and HOLDING the LEFT mouse button on a 3D Histogram, 
and moving the mouse. 
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• If you have changed the viewing angle as described above, you can restore the default 
viewing angle of the 3D Histogram by selecting Reset View from the right-click menu 
or the View menu. 

• The 3D Histogram option is not available if the Input Distribution is displayed (for 
Input Data variables) or if the Best Fit Distribution is displayed (for Calculated Data 
variables). 

 

Sampler 
The Sampler allows the user to obtain the coordinates of points on: 
 

• Cumulative Distribution (S-curve) Plots 
• Sensitivity Plots  

 
The Sampler is displayed as a vertical dotted line on a Cumulative Distribution plot, or as a 
horizontal line on Sensitivity plots. 
 
To use the Sampler: 

• SINGLE click the LEFT mouse button anywhere on the plot, and the sampler will 
jump to that location, and display the results. 

• Alternatively, press and HOLD the LEFT mouse button on the plot, and you will see 
the double-arrow icon. Move the mouse in the directions of the arrow, and the sampler 
will continuously display the values of points along the curve. 

 
For example, plot the Cumulative Safety Factor distribution, and move the Sampler to 
Safety Factor = 1 (actually it appears here by default). The Y coordinate displayed will be the 
Probability of Failure (i.e. the probability that the Safety Factor < 1).  
 
The display of the Sampler can be turned on or off in the right-click menu or the View 
menu. 
 

Input Distribution 
If the Data Type for a Histogram is one of your Input Data variables, then the Input 
Distribution option will display the Statistical Distribution, which you defined in the Input 
Data dialog for that input variable. This allows you to see how well the Statistical 
Distribution you defined was sampled. 
 
The Input Distribution option is available in the right-click menu, the View menu, and in 
the Histogram Plot Parameters dialog that comes up when you initially generate a 
Histogram. 
 
Interval markers can be displayed on the Input Distribution with the Markers option. 
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Best Fit Distribution 
If the Data Type for a Histogram is one of the Calculated Data Types (i.e. Safety Factor, 
Wedge Weight, etc.), then a Best Fit Distribution can be determined, using the 
Kolmogorov-Smirnov Goodness of Fit test. 
 
The Goodness of Fit test will determine which one of the Probability Density Functions 
available in ROCPLANE (Normal, Uniform, Triangular, Beta, Exponential, Lognormal) best 
fits (or best describes) the data. The distribution that best fits the data will be displayed on 
the histogram, and listed at the bottom of the plot. The Kolmogorov-Smirnov test is described 
in Ref. 7. 
 
The Best Fit Distribution option is available in the right-click menu, the View menu, and 
in the Histogram Plot Parameters dialog, when you initially generate a Histogram. 
 
Interval markers can be displayed on the Best Fit Distribution with the Markers option.  
 
NOTE: the Best Fit Distribution option is NOT available for Histograms of Input Data 
variables, since samples of an Input Data variable are generated from the Probability 
Density Function already specified in the Input Data dialog. For Input Data variables, the 
Input Distribution can be displayed. 
 

Relative Frequency 
The Relative Frequency option allows the user to scale the Frequency axis of Histograms 
in terms of Relative Frequency.  
 

• When the Relative Frequency option is toggled ON, the Frequency axis of a Histogram 
will be scaled such that the AREA under the distribution is equal to one. 

• If Relative Frequency is OFF, then the Frequency axis will be in terms of the actual 
number of samples. 

 
The Relative Frequency option is available in the right-click menu and the View menu. 
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Reset View 
The Reset View option can be used to reset the appearance of Histogram, Cumulative, 
Scatter or Sensitivity Plots, if the view has been zoomed or panned. 
 
Reset View will also reset certain other chart viewing options, such as the Sampler on 
Cumulative Distribution plots, for example. 
 
Reset View is available in the right-click menu, and the View menu. 
 

Show Failed Wedges 
The Show Failed Wedges option is applicable for Histogram and Scatter plots, and 
highlights the distribution of failed wedges (i.e. wedges with a safety factor less than 1) on 
Histogram or Scatter plots. 
 
When Show Failed Wedges is toggled on: 

• On a Histogram plot, the distribution of failed wedges will be superimposed over the 
total distribution, and coloured red. 

• On a Scatter plot, each data point representing a failed wedge will be coloured red. 
 
The Show Failed Wedges option is very useful, because it allows the user to see the 
relationship between wedge failure, and any given input variable (e.g. Friction Angle) or 
output variable (e.g. Wedge Weight). 
 
NOTE: on a Safety Factor Histogram, the failed wedges (safety factor less than 1) are 
ALWAYS highlighted in red. The Show Failed Wedge option is in effect by default, and is not 
available as a menu option for a Safety Factor Histogram. 
 
Show Failed Wedges is available in the right-click menu, and the View menu. 
 

Show Regression Line 
The Show Regression Line option is only applicable for Scatter plots, and can be used to 
toggle on or off the display of the best fit linear regression line for a Scatter plot. 
 
Note that the correlation coefficient, and y-intercept and slope (alpha and beta) for the best 
fit linear regression line, are always listed at the bottom of a Scatter plot, even if the 
regression line is not displayed. 
 
The Show Regression Line option is available in the right-click menu and the View menu. 
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Chart Properties 
The Chart Properties option allows the user to customize: 
 
Axis ranges 
Axis titles 
Chart colours 
 
for Histogram, Cumulative, Scatter and Sensitivity plots. 
 
Chart Properties is available in the right click menu and the View menu. 
 
Chart Colours 
Whenever you change the chart colours in the Chart Properties dialog (Background, Chart 
Exterior, Chart Interior), these colours will become the default colours of ALL new charts 
which are generated (ie. Histogram, Cumulative, Scatter and Sensitivity). They will remain 
the default chart colours each time you start ROCPLANE. If you want to restore the original 
program default colours, then select the Restore Default Colours button in the Chart 
Properties dialog. This will restore the original program default colours, for all new charts 
which are created. It will not  change the colours of existing chart views. 
 

Chart in Excel 
After creating Histogram, Cumulative, Scatter or Sensitivity plots in ROCPLANE, the 
Chart in Excel option can be used to create the same plot in Microsoft Excel. 
 
To create a chart in Excel: 

1. Make sure the chart you wish to export is the active view. If not, click the mouse in the 
view to make it the active view. 

2. Select Chart in Excel, which is available in the right-click menu, the View menu, and 
in the toolbar. 

3. If you have the Microsoft Excel program on your computer, it will automatically be 
started. The raw data used to create the chart will be exported to Excel, and a chart 
will be automatically created. This is all done with a single mouse click! 

 
Also note the following options:  

• With the Export Dataset option, any or all data from a Probabilistic Analysis can be 
copied to the clipboard, saved to a file, or exported to Excel. 

• The Copy Data to Clipboard option can be used to copy the raw data for a single graph, 
to the Windows clipboard. 

 



 

 22 

Zoom and Pan 
Zooming and panning of chart views (Histogram, Cumulative, Scatter or Sensitivity plots) 
can be performed as follows: 
 
Pan 
Press the Shift key, and press and hold the left mouse button. Move the mouse in any 
direction to pan the chart in the view. 
 
Zoom Window 
Press the Ctrl key, and click and drag the left mouse button to draw a window. This will 
zoom into a specific area of a chart view. 
 
Zoom Mouse 
Press the Alt key, and press and hold the left mouse button. Move the mouse up or down to 
zoom the view in or out. 
 
In addition, if the 3D Histogram option is in effect on a Histogram view, the 3D chart can be 
viewed from any angle, by pressing and holding the left mouse button, and moving it within 
the view. 
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Analysis 

Project Settings 
The Project Settings dialog, available in the Analysis menu and the toolbar, allows the 
user to enter a Project Title, select a Unit System, and Analysis Type. 
 
Project Title 
The Project Title will appear in the Info Viewer listing and on printouts of the wedge views. 
 
Unit System 
The Unit System determines the length and force units used in the input data dialogs and 
the analysis. 
 
Analysis Type 
In ROCPLANE, wedge stability can be assessed using either: 
 

• DETERMINISTIC (safety factor), or  
• PROBABILISTIC (probability of failure) 

 
analysis methods.  
 

• In a DETERMINISTIC analysis ROCPLANE computes the factor of safety for a single 
wedge of known input parameters. 

• In a PROBABILISTIC analysis, statistical input data can be entered to account for 
uncertainty in orientation and other input parameters. This results in a safety factor 
distribution, from which a probability of failure is calculated. 

 
Note that the Analysis Type can also be selected from the drop-down list in the toolbar. 
 

Compute 
The Compute option in the toolbar or the Analysis menu can be used to re-run a 
ROCPLANE analysis at any time. Compute has exactly the same effect as selecting the 
Apply button on the Input Data dialog. However, note that: 
  

• If your Analysis Type is DETERMINISTIC, Compute is not necessary, since you will 
have already calculated the Safety Factor with the Apply button in the Input Data 
dialog. The Safety Factor will NOT change when you re-compute a model with 
DETERMINISTIC data. 
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• If your Analysis Type is PROBABILISTIC, Compute (or Apply) can be used to re-run 

your ROCPLANE model with probabilistic Input Data. If the Pseudo-Random 
Sampling option in the Input Data dialog is NOT selected, analysis results will be 
different each time you re-run a Probabilistic Analysis. Pseudo-Random Sampling 
allows users to obtain reproducible results for a Probabilistic analysis. See the 
Sampling Method topic for details. 

 
In addition to the Compute and Apply buttons, a ROCPLANE analysis is also performed 
each time: 

• A file is opened. 
• Bolts are added, edited or deleted. 

 

Sensitivity Analysis 
The effect of uncertainty in the values of input parameters can be explored using a 
sensitivity analysis. In sensitivity analysis values of model parameters are varied across a 
range of likely values and the effect on computed factors of safety observed. This exercise 
helps identify the parameters that have the most effect on the stability of a sliding block, and 
can be used to compare the effectiveness of various remedial measures. 
 
Sensitivity plots are plots of factor of safety results against percentage changes in specified 
model parameters. On sensitivity plots, the gradient of a curve for a parameter indicates the 
effect that parameter has on the factor of safety of a sliding mass. Steeper rising or falling 
curves indicate greater influence on the factor of safety. 
 
To generate a sensitivity plot: 
 

1. Select Analysis →→→→ Sensitivity from the menu, or the "Sensitivity" toolbar button.  
2. From the ensuing dialog select the first available checkbox. The input data fields 

beside the checkbox are activated. 
3. From the dropdown list of parameters, select the parameter for which you desire a 

sensitivity plot. 
4. Enter a range within which you would like the parameter to vary. (To assist you in 

doing so, ROCPLANE automatically displays the mean value of the parameter entered 
in the Input Data dialog.) 

5. If you would like sensitivity plots for other parameters repeat steps 2 to 4. When done 
selecting parameters, click OK. 

6. On a single graph, ROCPLANE will generate the specified sensitivity plot(s). 
 
NOTE: 

• A Sensitivity graph is generated by subdividing each variable range (defined by the 
From and To values in the Sensitivity dialog), into 50 intervals, and calculating the 
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safety factor at each value of the variable between the From and To values. If you right-
click on the graph, and select the Markers option, you will see the actual points used to 
generate the curve(s).  

• The Percent Change (on the horizontal axis of a Sensitivity Graph) is the relative 
difference between the Minimum value of a variable ( 0 percent) and the Maximum 
value of a variable (100 percent), according to the From and To ranges you have entered 
in the Sensitivity dialog. 

• You can modify the data in an existing Sensitivity plot, by right-clicking the mouse in 
the plot, and selecting Update Sensitivity Data 

 

2D Wedge View 
A 2D view of the wedge model is available by selecting the 2D View option from the toolbar 
or the Analysis menu.  
 
This will generate a new view which only displays the 2D wedge model. It is important to 
remember that the ROCPLANE analysis is a 2D analysis, and that the 3D Wedge View 
display is for visualization purposes only. 
 
The 2D view can display model lengths and angles, applied and resultant forces, and tables 
of analysis results and input data. The display can be customized with the Display Options 
dialog. 
 

NOTE – if you have already generated the 2D Wedge View, and you have multiple views 
open, you can re-select the 2D View option at any time, to return to the 2D View. This will 
NOT generate a new view, but will simply return you to the existing 2D Wedge View. 

 

Info Viewer 
The Info Viewer option opens a view that displays a convenient summary of model and 
analysis parameters. The Info Viewer can be accessed by selecting Analysis →→→→ Info 
Viewer or the "Info Viewer" toolbar button. The information listed in the Info Viewer is 
very useful, and it is recommended that users examine this information, so that they can 
become familiar with the information available from a ROCPLANE analysis.  
 
The Info Viewer listing can be printed. It can also be copied to the clipboard by right-
clicking in the view and selecting Copy to Clipboard. Once it is on the clipboard, it can be 
pasted into a word processor or spreadsheet for inclusion in reports or other documents. 
 
Analysis Results 
If your Analysis Type is PROBABILISTIC, the Info Viewer lists a summary of Trial, Valid 
and Failed Wedges. Depending on your input geometry, it is possible for the Probabilistic 
Sampling of the Input Data to generate invalid wedge geometries.  
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In general: 
Number of Valid Wedges = Number of Trial Wedges – Number of Invalid Wedges 
Probability of Failure = Number of Failed Wedges / Number of Valid Wedges 
 
Current Wedge Data 
If your Analysis Type is PROBABILISTIC, you will see a Current Wedge Data listing in the 
Info Viewer. By default, this displays data for the mean wedge (i.e. the wedge based on the 
mean input data). The Current Wedge Data can also display data for ANY WEDGE 
generated by the Probabilistic Analysis. See the Viewing Other Wedges topic for details. 
 

Input Data 
Overview of Input Data 
ROCPLANE computes the factor of safety for the sliding of a block / wedge formed in a rock 
slope by: 
 

1. The face of the slope 
2. A discontinuity that strikes parallel to the slope and daylights into the slope face  
3. The upper ground surface, and 
4. A tension crack (optional). 

 
A typical problem geometry is illustrated below. 
 

  
Typical planar wedge geometry for ROCPLANE analysis.  
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At an early stage in the solution process, ROCPLANE checks if the geometry of a model is 
valid, before proceeding to calculate a Safety Factor or Probability of Failure for a sliding 
block. For more information on the validation of model geometry see the Geometry 
Validation topic. 
 
To enter model parameters, select the "Input Data" toolbar button or Analysis →→→→ Input 
Data from the menu. This opens the Input Data dialog. This dialog allows you to define the 
following model input parameters: 
 
Slope Angle , Slope Height, Unit Weight  
Upper Face Angle , Bench Width Analysis (optional)  
Failure Plane Angle , Waviness  
Failure Plane Strength  
Tension Crack Angle , Location (optional)  
Water Pressure  
Seismic Coefficient  
External Force  
Statistical Sampling (Probabilistic Analysis)  
 

Input Data Dialog 
Based on the setting of the Analysis Type option, the Input Data dialog is configured for 
either DETERMINISTIC or PROBABILISTIC input. 
 
The Input Data dialog in ROCPLANE works a little differently from a regular dialog: 
 

1. It is known as a "roll-up" dialog, since it can be "rolled-up" (minimized) or "rolled-down" 
again, by selecting the "up" or "down" arrow in the upper right corner of the dialog. 

2. You can also minimize / maximize the Input Data dialog, by double-clicking the left 
mouse button on the title bar of the dialog. 

3. It can be left up on the screen while performing other tasks. When not needed, it can be 
"rolled-up" and dragged out of the way (for example, the top of the screen) with the 
LEFT mouse button. 

4. If multiple files are open, the Input Data dialog will always display the data in the 
active file. 

5. The F3 function key can be used as a shortcut to open the Input Data dialog. 
 
You may find these properties of the Input Data dialog useful, for example, when performing 
parametric analysis, or when working with multiple files. 
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Slope 
Slope Angle 
In ROCPLANE there is no restriction on the inclination of the face of the slope; it can exceed 
90 degrees (ie. the slope crest can overhang the toe of the slope) but must form a valid wedge 
or sliding block with the other wedge planes. (See the Geometry Validation topic for more 
information.) 
 
Slope Height 
The Slope Height is the VERTICAL distance from the toe of the slope to the crest (the 
intersection of the slope face with the upper slope). 
 
Unit Weight 
The Unit Weight of the rock mass is used to determine the total weight of the wedge. 
 

Upper Face 
Angle 
The dip of the upper face of the slope. 
 
Bench Width Analysis 
Normally, the wedge size determined by ROCPLANE is based on the Slope Height. However, 
the user can scale the wedge size according to the width of a bench (Bench Width), by 
selecting the Bench Width checkbox, and entering a value for the width.  
 
NOTE: 
 

• The Bench Width is defined as the HORIZONTAL distance from the CREST of the 
slope, to the rearmost wedge vertex, on the Upper Face. This distance is always 
measured HORIZONTALLY, even if the Upper Face Angle is not horizontal. 

• In order to have an effect on the analysis, the Bench Width must define a SMALLER 
wedge than would be defined by the Slope Height. If the Bench Width value is too large, 
then the Slope Height will determine the wedge size, as if the Bench Width option were 
not in use. 

• (NOTE: the maximum possible Bench Width, based on the Slope Height, is displayed in 
the Edit box underneath the Bench Width Analysis checkbox, when the Bench Width 
Analysis checkbox is not selected). 

• If a Tension Crack is defined, the Bench Width cannot define a SMALLER wedge than 
is defined by the distance of the Tension Crack from the crest. An error message will be 
displayed in this case. 
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Failure Plane 
The failure plane is the surface along which sliding of a block or wedge occurs. 
 
Angle 
This value refers to the dip of the failure or sliding plane in a model. 
 
Waviness 
Waviness is a parameter that can be included in calculations of the shear strength of the 
failure plane, for any of the strength models used in ROCPLANE. It accounts for the 
waviness (undulations) of the failure plane surface, observed over distances on the order of 1 
m to 10 m. (Ref. 6) 
 
Waviness is specified as the AVERAGE dip of the failure plane, minus the MINIMUM dip of 
the failure plane. A non-zero waviness angle, will always increase the effective shear 
strength of the failure plane. 
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Tension Crack 
A Tension Crack is optional in a ROCPLANE analysis. It can be included in a model by 
selecting the Tension Crack checkbox in the Input Data dialog.  
 
When included in a model, a Tension Crack can be specified in one of two ways: 
 

• Minimum Factor of Safety Location – this option gives the location of the critical 
tension crack that provides the minimum factor of safety for a given model 

• Specify Location – this option allows a user to specify a location for a tension crack. The 
location is specified as a HORIZONTAL distance from the crest of the slope. 

 
ROCPLANE examines how the tension crack intersects with the Failure Plane and Upper 
Face, and only accepts those cases where the tension crack truncates the wedge in a valid 
manner (two examples of valid wedge truncation are shown in the figure below). If the 
tension crack plane does not form an acceptable wedge with the other planes, a warning 
message will be displayed when you select the Apply button to compute. 
 

  
Example of valid truncation of wedges 

 
Angle 
In addition to vertical tension cracks, ROCPLANE can account for non-vertical tension 
cracks. You can enter a value into the Angle edit box to specify an angle of inclination of a 
tension crack from the horizontal. The default value is 90 degrees, the vertical position.  
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Distance from Crest 
This allows a user to specify the HORIZONTAL distance of the Tension Crack from the slope 
crest, if the Specify Location option is used.  
 
If the Minimum FS Location option is used, then the Distance from Crest edit box is 
disabled, however, it will display the calculated value of the Minimum FS Location, when the 
Apply button is selected.  
 
NOTE: the Distance from Crest is always measured horizontally, even if the angle of the 
Upper Slope Face is not horizontal. 
 

Strength 
A critical assumption in planar slope stability analysis involves the shear strength of the 
sliding surface. There are several models in rock engineering that establish the relationship 
between the shear strength of a sliding surface and the effective normal stress acting on the 
plane. ROCPLANE offers the following widely accepted shear strength models: 
 
Mohr-Coulomb 

In this model the relationship between the shear strength, τ, of the failure plane and the 

normal stress, , acting on the plane is represented by the Mohr-Coulomb equation: 

 

where  is the friction angle of the failure plane and c is the cohesion. 
 
Barton-Bandis 
The Barton-Bandis strength model establishes the shear strength of a failure plane as: 

 

where  is the basic friction angle of the failure surface, 

JRC is the joint roughness coefficient, and JCS is the joint wall compressive strength. 
 
Hoek-Brown 
This is the original Hoek-Brown strength criterion (Ref. 1) which establishes rock mass 
strength according to the formula: 
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where  is the major principal stress,  is the minor principal stress,  is the uniaxial 
compressive strength of the intact rock, and m and s are material constants for the rock 
mass.  
 
NOTE: For the Hoek-Brown (and Generalized Hoek-Brown) criteria, the relationship 
between shear strength and normal stress is derived from the Hoek-Brown equations, which 
are in terms of principal stresses. 

 
Generalized Hoek-Brown 
The Generalized Hoek-Brown criterion establishes strength according to the formula: 

 

where  is the major principal stress,  is the minor principal stress,  is the uniaxial 

compressive strength of the intact rock,  is a material constant for the rock mass, and s 
and a are constants dependent on the characteristics of the rock mass.  
 
NOTE: if you are using the Generalized Hoek-Brown criterion, you can estimate the 
parameters of the Generalized Hoek-Brown equation, by selecting the GSI button in the 
dialog. This will display a Parameter Calculator dialog, which allows you to estimate the 
equation parameters from values of intact rock constant mi, and GSI (Geological Strength 
Index). Furthermore, within the Parameter Calculator dialog, you may access dialogs for 
the estimation of mi based on rock type, and the estimation of GSI based on rock structure 
and surface conditions. 
 
Power Curve 

The Power Curve model for shear-strength, , of a plane is given by the relationship: 

 
a, b and c are parameters, typically obtained from a least-squares regression fit to data 

obtained from small-scale shear tests.  is the normal stress acting on the failure plane. 
(Ref. 6) 
 



 

 33

Waviness Angle 
Waviness is a parameter that can be included in calculations of the shear strength of the 
failure plane, for any of the strength models used in ROCPLANE. It accounts for the 
waviness (undulations) of the failure plane surface, observed over distances on the order of 1 
m to 10 m. (Ref. 6) A non-zero waviness angle, will always increase the effective shear 
strength of the failure plane, regardless of the strength model which is in use. Waviness is 
specified along with the Failure Plane orientation, rather than with the strength parameters, 
see the Failure Plane topic for information. 
 

Water Pressure 
By default, Water Pressure is NOT applied to a ROCPLANE model. The default analysis 
therefore assumes a DRY slope. 
 
To include Water Pressure in the analysis, select the Water Pressure checkbox in the Input 
Data dialog. There are four water pressure distribution models available: 
 

• Peak Pressure – Mid Height 
• Peak Pressure – Toe 
• Peak Pressure – Tension Crack Base 
• Custom Pressure 

 
These distributions are illustrated below, for models with and without a tension crack. 
 
Peak Pressure Mid Height 
The Peak Pressure Mid Height option assumes that the maximum water pressure occurs at 
the mid height of the water level in the slope. The pressure is assumed to be zero at the toe of 
the slope, with linear pressure variation between zero and the maximum pressure. 
 

A        B    
 
Peak Pressure Mid Height water pressure option, without tension crack (A) and with tension crack 
(B). 
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Peak Pressure Toe 
The Peak Pressure Toe option assumes that the maximum water pressure occurs at the toe 
of the wedge. This is the worst case scenario, since it will result in the maximum hydrostatic 
force being applied to the wedge. This may occur if drainage at the toe of the slope becomes 
blocked, for example by freezing of water. The pressure variation is linear from the 
maximum at the toe, to zero at the top of the water level in the slope. 
 

A  B    
 
Peak Pressure Toe water pressure option, without tension crack (A) and with tension crack (B). 

 
Peak Pressure Tension Crack Base 
The Peak Pressure Tension Crack Base option assumes that the maximum water pressure 
occurs at the base of the tension crack. This model is only applicable if your model includes a 
tension crack. The pressure is assumed to be zero at the toe of the slope, with linear pressure 
variation between zero and the maximum pressure, on both the failure plane and the tension 
crack.  
 
NOTE: with this model, you may choose to turn OFF the water pressure on the failure plane, 
by selecting the "No Failure Plane Pressure" checkbox. In this case, water pressure will only 
be applied on the tension crack. This can be used to model the case where the failure plane is 
impermeable. 
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A     B     
 
Peak Pressure Tension Crack Base option. Pressure on both tension crack and failure plane (A) 
and pressure on tension crack only (B). 

 
Custom Pressure 
The Custom Pressure water pressure option, allows the user to specify the actual (average) 
water pressure on the failure plane and the tension crack. This is useful if actual water 
pressure data is available. Remember that these values represent the AVERAGE water 
pressure on the wedge planes, and that only a single value can be entered for the failure 
plane, and a single value for the tension crack. 
 

A  B    
 
Custom Pressure water pressure option, without tension crack (A) and with tension crack (B). 

 
NOTE: for the Custom Pressure option, the Unit Weight and Percent Filled options are not 
applicable, since the actual (average) pressure is being entered. 
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Unit Weight 
The Unit Weight option for water pressure allows the user to specify the unit weight of 
water. The Unit Weight of water is used to calculate the value of Peak Pressure for the 
following water pressure distribution options: 
 

• Peak Pressure Mid Height 
• Peak Pressure Toe 
• Peak Pressure Tension Crack Base 

 
The Unit Weight option is not applicable for the Custom Pressure option, since the water 
pressure is entered directly by the user for this option. 
 
Percent Filled 
The Percent Filled option allows the user to specify the water level in the slope. Note: 

• For the Peak Pressure Mid Height and Peak Pressure Toe options, the Percent Filled is 
relative to the total height of the wedge (see figures A and B) 

• For the Peak Pressure Tension Crack Base option, the Percent Filled TC represents the 
level of water in the tension crack (see figure C) 

• Percent Filled is not applicable for the Custom Pressure option. 
 

A  B    C      
 
Percent Filled = 50% for Peak Pressure Mid Height (A), Peak Pressure Toe (B) and Peak Pressure 
TC Base (C). 

 
Display of Water Pressure Forces 
If Water Pressure has been applied to a model, this will be indicated in the 3D Wedge View, 
by blue shading of the wedge failure plane and tension crack. If the Percent Filled is less 
than 100%, the actual water level will be indicated by the level of the blue shading on the 
wedge planes.  
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Also, the water forces will be represented on the 3D Wedge model, by blue arrows displayed 
at the center and directed normal to the Failure Plane and Tension Crack (if present) of the 
sliding block. These arrows are symbolic and indicate that Water Pressure has been applied. 
They do NOT indicate the magnitude or method of Water Pressure calculation.  
 
The display of water pressure can be turned on or off, and the default colour can be changed, 
in the Display Options dialog.  
 
On the 2D Wedge View, the actual water pressure distributions are displayed, as indicated in 
the above figures. 
 

Seismic Force 
Seismic Force can be applied to the wedge by selecting the Seismic checkbox in the Input 
Data dialog, and entering the following data: 
 
Seismic Coefficient 
The seismic coefficient is a dimensionless number that defines the seismic acceleration as a 
fraction of the acceleration due to gravity. Typically the Seismic Coefficient might be around 
0.1 to 0.2.  
 
If α = Seismic Coefficient, g = acceleration due to gravity = 9.81 m/s2, and m = mass of the 
sliding block, then the Seismic Force applied to the block, F = m α g. 
 
Direction 
By default the Seismic Force will be applied to the wedge in the HORIZONTAL direction. 

• However, the user may define the Seismic force at any angle from the horizontal, by 
selecting the USER DEFINED option for Direction, and entering an Angle. 

 
Display of Seismic Force 
If Seismic Force has been applied to a model, the Force will be represented on the model as a 
yellow arrow at the lowermost wedge vertex on the slope face. The arrow is symbolic and 
indicates the direction and existence of a Seismic Force. It does NOT indicate the magnitude 
of the force. The display of this arrow can be turned on or off, and the default arrow colour 
can be changed, in the Display Options dialog. 
 
Note that the location of the Seismic Force display does NOT indicate the actual location of 
the force applied in the analysis. As with all other forces in ROCPLANE, a Seismic Force is 
applied through the centroid of the wedge, during the analysis. 
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External Force 
External Forces (e.g. a structural load on the upper surface of a slope, or the force applied by 
a waste rock berm to the toe of a slope) can be applied to the sliding block, with the External 
Forces option in the Input Data dialog. To include External Forces in the analysis: 
 

1. Select the Number of External Forces. 
2. Enter the Angle (of inclination) and Magnitude of each force. 
3. Select the Apply button to run the analysis. 

 
How External Forces are Implemented 
In the ROCPLANE analysis, an External Force is exactly equivalent to a rock bolt, using the 
ACTIVE bolt model. This means that an External Force with the same orientation as a rock 
bolt, and with a Magnitude equal to the Capacity of the rock bolt, will have exactly the same 
effect on the Safety Factor, if the bolt model is ACTIVE. See the How Bolts are Implemented 
topic for more information. 
 
Display of External Forces 
If External Forces have been applied to a model, the Forces will be represented on the model, 
as purple arrows at the center of the wedge face. These arrows are symbolic and indicate the 
direction and existence of External Forces. They DO NOT indicate the magnitude of the 
forces. The display of these arrows can be turned on or off, and the default arrow colour can 
be changed, in the Display Options dialog. 
 
Note that the location of the External Force display does NOT indicate the actual location of 
the forces applied in the analysis. As with all other forces in ROCPLANE, External Forces 
are applied through the centroid of the wedge, during the analysis. 
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Probabilistic Input 
Overview of Probabilistic Input 
If your Analysis Type is PROBABILISTIC, you will be able to define any or all of the 
following as random variables, in the Input Data dialog: 
 

• Angle of the Failure Plane, Slope Face, Upper Slope Face, and Tension Crack. 
• Various parameters of the different shear strength models of the Failure Plane. For 

example, for the Mohr-Coulomb model Cohesion and Friction Angle can be defined as 
random variables. 

• Percent Filled option for water pressure  
• Seismic Coefficient and user-defined Angle 

 
To define a parameter as a random variable, select the desired Statistical Distribution from 
the dropdown list of distributions for the parameter, and then enter appropriate standard 
deviation and minimum / maximum values. 
 
Any variable that is NOT assigned a Statistical Distribution is assumed to have a 
deterministic value (Mean Value) and will thus not be sampled statistically in the analysis. 
 
To carry out a PROBABILISTIC analysis, at least one Input Data variable must be defined 
as random. 
 

Random Variables 
To define a parameter as a random variable in the Probabilistic Input Data dialog, first 
toggle the Statistical Distribution for that variable from "None" to one of the six possible 
choices: 
 

• NORMAL  
• UNIFORM  
• TRIANGULAR  
• BETA  
• EXPONENTIAL  
• LOGNORMAL  

 
Once a statistical distribution has been selected, you will then be able to enter: 
 

• Standard deviation 
• Relative minimum and maximum values 
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NOTE!!! 

• The minimum / maximum values are specified in the Input Data dialog as RELATIVE 
quantities (i.e. as distances from the mean), rather than as absolute values.  

• EXAMPLE: if the Mean Angle = 45, and the Relative Minimum = 10, then the actual 
Minimum = 35 degrees. 

• All references in the ROCPLANE Help topics to "minimum" and "maximum" values 
that are not used in the context of the entry of statistical input data, refer to absolute 
minimums and maximums (i.e. mean – relative minimum and mean + relative 
maximum), and not to the relative values entered in the Input Data dialog. 

 

Correlation Coefficient (Cohesion and Friction Angle) 
In the Probabilistic Input Data dialog, the user may define a correlation coefficient between 
Cohesion and Friction Angle, if the Mohr-Coulomb strength model is used for the Failure 
Plane.  
 
 The correlation coefficient option will only be enabled if: 
 

1. BOTH Cohesion and Friction Angle are defined as random variables (ie. assigned a 
statistical distribution) 

2. Normal or Uniform distributions are defined (will not work for other distribution types). 
 
It is known that Cohesion and Friction Angle are related in a general way, such that 
materials with low friction angles tend to have high cohesion, and materials with low 
cohesion tend to have high friction angles. This option allows the user to define the 
correlation between these two variables. 
 
By default, when the checkbox is NOT selected, Cohesion and Friction Angle are treated as 
completely independent variables.  
 
In order to see the effect of the correlation coefficient, try the following: 
 

1. Create a file with probabilistic input data.  
2. Use Normal or Uniform distributions for Cohesion and Friction Angle. 
3. Select the "Correlation coefficient between cohesion and friction angle" checkbox, in the 

Input Data dialog. 
4. Enter a correlation coefficient. (Initially, use the default value of –0.5.) 
5. Run the probabilistic analysis. 
6. Create a Scatter Plot of Cohesion vs. Friction Angle. 
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7. Note the correlation coefficient listed at the bottom of the Scatter Plot. It should be 
approximately equal to the value entered in the Input Data dialog. (It will not in 
general, be exactly equal to the user-defined correlation coefficient, since the results are 
still based on random sampling of the input data distributions). 

8. Note the appearance of the plots (ie. the degree of scatter between the two variables). 
9. Repeat steps 4 to 8, using correlation coefficients of -0.6 to -1.0, in 0.1 increments. 

Observe the effect on the Scatter Plot. Notice that when the correlation coefficient is 
equal to –1, the Scatter Plot results in a straight line. 

 

NOTE: the default correlation coefficient of –0.5 is a good typical value to use, if more precise 
data is not available. 
 

Sampling Method 
In the Probabilistic Input Data dialog, the user can set the Number of Samples, the 
statistical Sampling Method (Monte Carlo or Latin Hypercube), and choose Pseudo-Random 
Sampling, for the ROCPLANE Probabilistic Analysis. 
 
Monte Carlo Method 
The "Monte Carlo" sampling technique uses random numbers to generate input data samples 
consistent with specified probability distributions. Monte Carlo techniques are now 
commonly applied to a wide variety of problems involving random behaviour, where the 
passage of time plays no substantive role. As a result, Monte Carlo simulations are generally 
static rather than dynamic (Ref. 7). 
 
Latin Hypercube Method 
The Latin Hypercube sampling technique is a more recent development, which gives 
comparable results to the Monte Carlo technique but with fewer samples (Refs. 8, 9). The 
method is based upon "stratified" sampling – a probability distribution is first divided into a 
number of segments or strata, and then accompanied by random selection within each 
stratum. Typically, an analysis using 1000 samples obtained by the Latin Hypercube 
technique will produce comparable results to a Monte Carlo analysis that uses 5000 samples 
(Ref. 10). 
 
Pseudo-Random Sampling 
Pseudo-Random Sampling allows the user to obtain reproducible results from a Probabilistic 
Analysis. If the Pseudo-Random Sampling checkbox is ON, this means that the SAME "seed" 
number is always used to generate random numbers for the sampling of the input data 
distributions. This results in identical sampling of the input data distributions, each time the 
analysis is run (with the same input parameters). The Probability of Failure, mean Safety 
Factor, and all other analysis output, will be reproducible. This can be useful for 
demonstration purposes, the discussion of example problems, etc. 
 
By default, the Pseudo-Random Sampling checkbox is ON.  
 



 

 42 

If you wish to run probabilistic analyses with true Random Sampling, then turn the Pseudo-
Random Sampling checkbox OFF. In this case, a DIFFERENT "seed" number is used each 
time the ROCPLANE Probabilistic analysis is run (ie. each time Compute or Apply is 
selected). Each analysis will therefore produce different results, and the Probability of 
Failure and the mean Safety Factor, may vary with each run. 
 

Normal Distribution 
The NORMAL (or Gaussian) distribution is the most common probability distribution 
function (PDF), and is generally used for probabilistic studies in geotechnical engineering. 
Unless there is good reason to use one of the other five PDFs available in ROCPLANE, it is 
recommended that the user choose the NORMAL PDF. 
 
For a NORMAL distribution, about 68% of observations should fall within one standard 
deviation of the mean, and about 95% of observations should fall within two standard 
deviations of the mean.  
 

  
Normal probability density function, showing standard deviation ranges. 

 
Truncated Normal Distribution 
A truncated NORMAL distribution can be defined for a variable by setting the desired 
minimum and/or maximum values for the variable. For practical purposes, minimum and 
maximum values that are at least 3 standard deviations away from the mean generate a 
complete normal distribution. If the minimum / maximum values are less than 3 standard 
deviations away from the mean, the distribution is visibly truncated. 
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Uniform Distribution 
A UNIFORM distribution can be used to simulate a random variation between two values, 
where all values in the range are equally probable. 
 
A UNIFORM distribution is entirely specified by the minimum and maximum values. The 
mean value of a UNIFORM distribution is simply the average of the minimum and 
maximum values, and cannot be independently specified. 
 

  
Uniform probability density function. 
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Triangular Distribution 
You may wish to use a TRIANGULAR distribution in some cases, as a rough approximation 
to a random variable with an unknown distribution. 
 
A TRIANGULAR distribution is specified by its minimum, maximum and mean values. It 
does not have to be symmetric, and can be skewed either to the left or right by entering a 
mean value greater than or less than the average of the minimum and maximum values. 
 

  
Triangular probability density function. Minimum = a, maximum = b, mode = c. For a symmetric 
distribution, mean = mode. 

 
NOTE:  
For a non-symmetric TRIANGULAR distribution, the mean value is not equal to the mode. 
The mode is the value of the variable at the peak of the TRIANGULAR distribution. The 
mean of a TRIANGULAR distribution has the following behaviour: 
 

1. In general, the mean of a triangular distribution is always given by: 

  
2. If the distribution is symmetric, then the mean is equal to the mode. 
3. For a left triangular distribution, the mode = minimum, and the mean = (2*minimum + 

maximum) / 3.  
4. For a right triangular distribution, the mode = maximum, and the mean = 

(2*maximum + minimum) / 3. 
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Beta Distribution 
The BETA distribution is a very versatile function, which can be used to model probability 
density curves of several different shapes, such as those shown below. 
 

  
Beta (α1, α2) density functions (Ref. 7) 

 
The form of the BETA distribution is determined by the shape parameters α1 and α2. Both 
α1 and α2 are always positive (greater than 0). The relationship between the shape 
parameters of the BETA distribution and the ROCPLANE input data is as follows:  
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The standard deviation is the positive square root of the variance. 
 
Note that the above equations apply to a beta random variable on [0,1]. To rescale and 
relocate to obtain a beta random variable on [a, b] of the same shape, use the transformation 
a + (b–a)X 
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Exponential Distribution 
The EXPONENTIAL probability density function is available in ROCPLANE:  
 

  
Exponential probability density function. 

 
NOTE: 

1. The range of values must always be positive for an EXPONENTIAL distribution. It 
must therefore not be used for orientation distributions which include negative values 
(i.e. Dip values less than zero). 

2. The mean of an EXPONENTIAL distribution is always equal to its standard deviation. 
This is a property of the EXPONENTIAL distribution, and cannot be altered by the 
user. 

3. Like the NORMAL distribution, the EXPONENTIAL distribution can be truncated by 
entering the desired minimum and maximum values (the basic EXPONENTIAL 
distribution varies from zero to infinity). 

 
The EXPONENTIAL distribution is sometimes used to define events, such as the occurrence 
of earthquakes or rockbursts, or quantities such as the length of joints in a rockmass. Of the 
currently defined statistical variables in ROCPLANE, you may occasionally find it useful for 
modeling joint cohesion, for example. 
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Lognormal Distribution 
If a random variable has a Lognormal distribution, then its natural logarithm has a Normal 
distribution. This is the meaning of the term Lognormal. 
 
Like the Exponential distribution, the Lognormal distribution can only be used for variables 
which are always positive. 
 
A Lognormal distribution can be useful for modeling variables such as cohesion, for example, 
which may have a large peak in the distribution near zero and then taper off gradually for 
larger values. 
 

  
Lognormal probability density functions. 

 

Further Reading 
An excellent introduction to probability theory in the context of geotechnical engineering can 
be found in Chapter 2 of Ref. 10.  Probability, reliability and statistical methods in 
engineering design is covered in Ref. 12  
 
More comprehensive and detailed information can be found in statistics textbooks. For 
example, Chapter 6 of Ref. 7 provides an excellent guide to the selection of input probability 
distributions. Ref. 11 provides a summary of over 30 different probability density functions, 
in a quick-reference format. 
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Analysis 
Running the Analysis 
To run a ROCPLANE analysis, select the Apply button in the Input Data dialog, after 
entering all of your input data. 
 
If the Analysis Type = DETERMINISTIC: 

• The Safety Factor will be immediately calculated and displayed in the lower right 
corner of the dialog, along with the Wedge Weight, Normal Force, Resisting Force and 
Driving Force. 

 
If the Analysis Type = PROBABILISTIC: 

• The Probability of Failure will be calculated and displayed in the toolbar. Detailed 
statistical results can be viewed with the Plot Histogram, Plot Cumulative and Plot 
Scatter options in the Statistics menu. 

 
NOTE:  

1. The Compute button has exactly the same effect as selecting the Apply button in the 
Input Data dialog. This can be used for re-running a Probabilistic Analysis if the Input 
Data dialog is closed. It is not necessary for a Deterministic Analysis, since the Safety 
Factor will not change when you re-compute. 

2. When a file is opened in ROCPLANE, the analysis is automatically carried out, so that 
the user can immediately view results. Therefore it is only necessary to compute if you 
are changing the Input Data. 

3. The analysis is also run whenever bolts are added or modified. 
 
 

Geometry Validation 
ROCPLANE always checks if the model geometry is valid, before proceeding to calculate a 
Safety Factor for a given wedge.  
 
ROCPLANE checks whether the specified Slope Face, Upper Face and Failure Plane form a 
legitimate sliding block or wedge. (Examples of valid sliding blocks are shown in the figures 
below.)  
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Examples of valid sliding block geometries, when no tension crack is involved. 

 

In addition, ROCPLANE also examines how the tension crack intersects the other planes, 
accepting only those cases where the tension crack truncates the wedge in a kinematically 
admissible manner. If a Tension Crack is defined and a Bench Width specified, the Bench 
Width cannot define a wedge SMALLER than that defined by the distance of the Tension 
Crack from the crest. An error message will be displayed in this case. Examples of valid 
sliding block geometries with tension cracks are provided below. 
 

  
Examples of valid wedge geometries involving tension cracks. 
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If the Analysis Type = DETERMINISTIC:  

• You will receive an error message if there is a problem with your input geometry. 
 
If the Analysis Type = PROBABILISTIC:  

• Validation is first performed on the mean Input Data. If the mean orientation data 
does not form a valid wedge, then the entire Probabilistic Analysis will be aborted, and 
you will receive an error message. If the mean wedge is valid, but invalid wedges are 
generated during the statistical sampling, then these results are discarded, but the 
analysis is allowed to proceed. The Number of Valid Wedges for a Probabilistic 
Analysis is listed in the Info Viewer option. 

 

Re-Running Probabilistic Analyses 
The initial analysis of Input Data is always done as soon as you click the Apply button in the 
Input Data dialog. 
 
Later, you may re-run a Probabilistic Analysis by selecting the Compute button in the 
toolbar. In general, analysis results will be different each time you re-run a Probabilistic 
Analysis, unless the Pseudo-Random Sampling option is selected in the Input Data dialog. 
Pseudo-Random Sampling allows the user to obtain reproducible results for a Probabilistic 
analysis. See the Sampling Method topic for details. 
 
When you re-run a Probabilistic Analysis, all views of the current document will be 
automatically updated to reflect the current analysis results, including: 
 

• Histograms  
• Cumulative Distributions  
• Scatter Plots  
• Info Viewer  

 
NOTE: 
The Wedge view will NOT change when you re-compute, since the default wedge displayed is 
based on the mean Input Data, which is not affected by re-running the analysis. 
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Support 

Adding a Bolt 
Rock bolts are added to a ROCPLANE model with the Add Bolt option. This allows the user 
to evaluate the number, location, length and capacity of bolts necessary to stabilize a planar 
wedge (i.e. achieve a required Safety Factor or Probability of Failure). To add a rock bolt: 
 

1. Select Support →→→→ Add Bolt or the "Add Bolt" toolbar button. 
2. Move the cursor into the Top or Front orthogonal views. 

Notice that the cursor changes to an "arrow / rockbolt" icon.  
3. As you move the cursor over the wedge, notice that the "rockbolt" and "arrow" now line 

up – this indicates that you may add the bolt to the wedge. 
4. Click the LEFT mouse button at a point on the wedge where you want the bolt 

installed.  
5. The bolt will initially be installed NORMAL to the face of the wedge on which you 

clicked (i.e. normal to the Upper or Face slope). 
6. The Bolt Properties dialog will appear on the screen, which allows you to modify the 

bolt orientation and other properties – see the Bolt Properties Dialog topic for details. 
7. When the desired bolt properties have been entered, select OK. 
8. If you are not happy with the location of the bolt, select Cancel to delete the bolt. 

 
NOTE: 

• Bolts CANNOT be added in the Perspective view. 
 

Bolt Properties Dialog 
The Bolt Properties dialog, which appears when Adding or Editing Bolts, works as follows: 
 

1. Bolts in ROCPLANE may be defined as either Active or Passive. For information about 
the Active and Passive bolt models in ROCPLANE see the How Bolts are Implemented 
topic. 

2. If you modify the Capacity or Angle with the "arrow" buttons at the right of the input 
fields, the Safety Factor is immediately recalculated and displayed in the dialog as the 
values are being changed. This allows the user to interactively modify the bolt 
properties, and immediately see the effect on the Safety Factor.  

3. Alternatively, values can be typed in to the dialog. In this case, the Safety Factor is 
NOT automatically re-calculated, the user must select the Apply button to apply typed 
in values. 

4. As the bolt Angle is changed, you will see the orientation of the bolt updated on the 
screen. 
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5. Changing the Length of the bolt will be visible on the model, but has NO effect on the 
Safety Factor, as long as the Anchored Length is greater than zero. 

6. The Anchored Length is the bolt length, which passes through the wedge, and is 
anchored in the slope behind the wedge. Anchored Length is automatically calculated 
whenever the values of Length or Plunge are changed, and cannot be changed by the 
user. Anchored Length must be greater than zero, or the bolt will have no effect on the 
Safety Factor (i.e. its effective capacity will be zero, and it will not be used in the 
analysis). 

7. When the bolt orientation, length and capacity are satisfactory, select OK, and the bolt 
will be added to the model (if you were Adding Bolts), or saved with the new properties 
(if you were Editing Bolts).  

8. If you are not happy with the location of the bolt, select Cancel, and the bolt will be 
deleted (if you were Adding Bolts). If you were Editing Bolts, all changes will be 
cancelled, even if you used the Apply button to apply the changes. 

 
NOTE: 
If your Analysis Type is PROBABILISTIC, the Safety Factor is calculated on the mean 
wedge input data. The Probabilistic Analysis, including the effect of the bolt you just added / 
edited, will be re-computed when you select OK in the Bolt Properties dialog (Step 7). 

 
Optimize 
In the Bolt Properties dialog, the orientation of an individual bolt can be optimized with the 
Optimize button. The Optimize button automatically determines the bolt orientation (Angle) 
that provides the maximum safety factor.  
 
Factor of Safety Option 
The Factor of Safety option in the Bolt Properties dialog will calculate the bolt Capacity 
necessary to achieve a specific Factor of Safety. To use this option: 

• Select the Factor of Safety option, and enter a desired Factor of Safety (e.g. 2.0) 
• Select the Apply button, and the Capacity will be automatically updated with the 

required capacity necessary to achieve the specified Factor of Safety. 
• Note that if the calculated capacity is NEGATIVE, this is not an error; this means that 

the user has entered a Factor of Safety, which is LESS than the Factor of Safety with 
NO support. A negative capacity means that the support force is actually applied in the 
opposite direction from the specified Angle. 

 
NOTE that since the Bolt Properties dialog only applies to individual bolts, you may wish to 
use the Factor of Safety option as follows: 

• Install a single bolt 
• Use the Factor of Safety option to determine the total Capacity necessary to stabilize 

the wedge 
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• You may then use this value for further design purposes (e.g. to calculate the required 
number of bolts of a specified capacity). This assumes that all bolts are installed at the 
same orientation. 

 
Bolts in a Probabilistic Analysis 
Bolts should be used with some caution in a Probabilistic Analysis. Since the bolts are added 
while viewing the mean wedge, the orientations of bolts added on the mean wedge may no 
longer be optimal in terms of support, to other wedges generated by the Probabilistic 
Analysis. You should keep this in mind, if you have used the Optimize button to optimize the 
bolt orientation on the mean wedge. 
 

How Bolts are Implemented 
Bolts are implemented in ROCPLANE planar wedge stability analysis as follows: 
 
Capacity and Orientation 

1. Bolts affect the Safety Factor through their Capacity and Orientation (Angle). 
2. Bolt capacities and orientations are added vectorially, and are included in the Safety 

Factor calculation as a single, equivalent force passing through the centroid of the 
wedge. Either the ACTIVE or PASSIVE bolt model will apply (see below). 

3. Multiple bolts that have the same orientation can therefore be simulated by a single 
bolt having the same total capacity. 

 
Length and Location 
Bolt Length has NO effect on the Safety Factor in ROCPLANE. As long as a bolt passes 
through the wedge, (i.e. Anchored Length > 0) the full capacity of the bolt will be applied in 
the analysis.  

1. However, if the Anchored Length of a bolt = 0 (i.e. if it does not pass through the 
wedge), then the bolt will have NO effect on the model - its effective capacity will be 
zero. 

2. The Location of bolts (on the face of the wedge) has NO effect on Safety Factor, since all 
forces in the wedge stability analysis are assumed to pass through the centroid of the 
wedge. 

3. The Length, Anchored Length and Location of bolts allow the user to visualize the 
practical problems of installing the bolts, but DO NOT enter into the Safety Factor 
calculations. 

 
Bolts vs. External Force 

1. A bolt is exactly equivalent to an External Force with the same magnitude and 
orientation, if the bolt model is ACTIVE (see below).  

As a suggested exercise, the user can verify that a bolt using the ACTIVE bolt model, and an 
equivalent External Force, result in the same Safety Factor, for a given wedge. 
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2. A bolt, and an External Force with the same magnitude and orientation, will NOT be 
equivalent, if the bolt model is PASSIVE (see below). 

 
Multiple Bolts 
Installation of multiple bolts is useful for visualizing the practical problems of bolt 
installation, and the necessary bolt lengths and spacing. It is also useful for back-calculating 
the Safety Factor of an existing wedge support system. 
 
However, since bolts in ROCPLANE simply behave as force vectors passing through the 
centroid of the wedge, the effect of multiple bolts on the Safety Factor can be simulated by: 
 

• A fewer number of bolts, or even a single bolt, with equivalent capacity and direction, 
or 

• An equivalent External Force (in the case of ACTIVE bolts). 
 
Active and Passive Bolt Models 
In general terms, the Factor of Safety is defined as the ratio of the forces resisting motion, to 
the driving forces. Driving forces include the mass of the wedge accelerated by gravity, 
seismic forces, and water pressure. Resisting forces arise from the cohesion and frictional 
strength of the sliding plane (Failure or Discontinuity Plane). 
 
Active Support is included in the ROCPLANE analysis as shown in Equation 1: 
 

  Eqn. 1 

where  is the normal component and  is the shear component of the force applied to 
the rock by the support.  
 
Active Support is assumed to act in such a manner as to DECREASE the DRIVING FORCE 
in the Factor of Safety calculation. Tensioned cables or rockbolts, which exert a force on the 
wedge before any movement has taken place, are considered as Active support. 
 
NOTE: External Forces are incorporated in the ROCPLANE analysis in the same manner as 
Active Support (i.e. according to Eqn. 1). 
 
Passive Support is included in the ROCPLANE analysis as shown in Equation. 2. 
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   Eqn. 2 
 
By this definition, Passive Support is assumed to INCREASE the RESISTING FORCE 
provided by shear restraint, in the Factor of Safety equation.  
 
Untensioned dowels or grouted cablebolts, which only develop a resisting force after some 
movement of the wedge has taken place, are considered as Passive support. 
 
Since the exact sequence of loading and movement in a rock slope is never known in advance, 
the choice of Active or Passive bolt models is somewhat arbitrary. The user may decide which 
of the two models is more appropriate for the wedge being analyzed. In general, Passive 
support will always give a lower Factor of Safety than Active support. 
 

Deleting a Bolt 
To delete bolts: 
 

1. Select Support →→→→ Delete Bolt or the "Delete Bolt" toolbar button. 
2. Move the cursor in the Top, Front or Side views. 
3. The cursor will change to a small "box". 
4. Hover the cursor over a bolt that you wish to delete. 
5. The bolt will change colour, to indicate that it is "selected". 
6. The properties of the selected bolt will be displayed in the status bar. This may help to 

identify bolts you wish to delete. 
7. Click the LEFT mouse button, and the bolt will be deleted. 
8. A new Safety Factor will immediately be calculated. 
9. Repeat steps 4 to 7 to continue deleting bolts. 
10. Press Escape to exit the Delete Bolts option. 

 
To delete ALL bolts at once: 

1. While in Delete Bolts mode, enter the asterisk (*) character on the keyboard. 
2. ALL bolts will be deleted from the model. 

 
NOTE: 
Bolts CANNOT be deleted in the Perspective view. 
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• If your Analysis Type is PROBABILISTIC, the Safety Factor for the mean wedge will 
be re-calculated each time a bolt is deleted. However, the Probabilistic Analysis will 
NOT be carried out until you exit the Delete Bolts mode. 

 

Editing a Bolt 
To edit the properties of an existing bolt: 
 
Select Support →→→→ Edit Bolt or the "Edit Bolt" toolbar button. 

1. Bolts are selected for editing in the same manner as for deleting – see the Delete Bolts 
topic for details. 

 
Once a bolt has been selected for editing: 
You will see the Bolt Properties dialog in the middle of the screen, displaying the properties 
of the selected bolt. 

2. You can modify the properties of the bolt, in the same manner as when you originally 
added the bolt. See the Bolt Properties Dialog topic for details. 

3. When you are finished editing the properties, select OK to save your changes. 
4. If you select Cancel, all changes will be cancelled, even if you used the Apply button to 

apply the changes. 
 
NOTE: 

• Bolts can only be edited one at a time in this manner. It is not possible to edit the 
properties of multiple bolts simultaneously. 

• A listing of all currently installed bolts and their properties can be found in the Info 
Viewer and also in the 2D Wedge View. 
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Statistics 

Plot Histogram 
To plot Histograms of results after a Probabilistic Analysis: 
 

1. Select Statistics →→→→ Plot Histogram or the "Plot Histogram" toolbar button. 
2. Select a Data Type from the dropdown list in the dialog. 
3. Enter a Number of Intervals. The default is 30, but any value between 1 and 500 can 

be entered. 
4. If the Data Type selected is a results variable calculated in the analysis, a Best Fit 

Distribution, using the Kolmogorov-Smirnov Goodness of Fit test, can be determined 
for the variable by selecting the Best Fit checkbox. 

5. If the Data Type selected is an Input Data variable, the Input Distribution can be 
plotted through selection of the Plot Input Distribution checkbox. 

6. Select OK. 
 
The Histogram will be generated, and the mean, standard deviation, minimum and 
maximum values for the data plotted, will be listed at the bottom of the Histogram. 
 
Several options are available in the right-click menu for Histograms, including: 
 
3D Histogram  
Input Distribution  
Best Fit Distribution  
Markers  
Show Failed Wedges  
Copy Data to Clipboard  
Copy View to Clipboard  
Chart in Excel  
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Data Types 
After a Probabilistic Analysis, the following data can be plotted on Histogram, Cumulative or 
Scatter plots: 
 
Calculated Data 
 
Safety Factor 
In most cases, the first thing you will want to view is the Safety Factor distribution since it is 
from this that the Probability of Failure is calculated. 
 
Wedge Weight 
The weight of each wedge (per unit thickness of the slope). 
 
Normal Force 
The Normal Force refers to the resultant force acting normal to the failure plane.  
 
Driving Force 
The driving forces consist of the down-slope component of the weight of the sliding block, 
forces generated by seismic acceleration, forces due to water pressures acting on various 
faces of the block, and external forces on the upper slope surface. 
 
Resisting Force 
The resisting forces comprise the shear strength of the sliding surface, artificial 
reinforcement of the slope or other stabilizing external forces, if present. 
 
Failure Plane Length 
This refers to the lengths of the failure planes for various sliding block geometries generated 
in a probabilistic analysis. 
 
Upper Face Length 
This refers to the lengths of the upper faces for various sliding block geometries generated in 
a probabilistic analysis.. 
 
Tension Crack Depth 
This data type allows users to plot the various tension crack depths generated in a 
probabilistic analysis. 
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Wedge Volume 
The volume of a wedge in ROCPLANE is numerically equal to its area since the program 
considers slices of unit thickness only.  
 
Percent Filled 
This data type is calculated only in analysis involving water pressures. In analysis involving 
tension cracks, Percent Filled refers to the water level in the Tension Crack. 
 
Input Data 
 
Input Data Variables 
Any Data Types listed after the Calculated Data types (see above), are your Input Data 
variables (Slope Height, Slope Angle, Upper Face Angle, Bench Width, etc.) to which you 
assigned Statistical Distributions. 
 
NOTE: 

• The Calculated Data types will always be available for plotting. 
• At least ONE Input Data variable will always appear in the Data Type list, since at 

least one Input Data variable must be assigned a Statistical Distribution, before a 
Probabilistic Analysis can be performed. 
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Safety Factor Histogram 
The Safety Factor Histogram represents the distribution of calculated Safety Factors for all 
valid planar wedges generated by the Probabilistic Analysis. 
 
Failed wedges (ie. Safety Factor < 1) are highlighted by the red bars at the left of the 
Histogram.  
 
The Probability of Failure in ROCPLANE is simply the number of Failed Wedges divided by 
the TOTAL number of VALID wedges generated in the analysis. 
 

• If any wedges have failed, then the Probability of Failure will be > 0. 
• If NO wedges have failed, then the Probability of Failure = 0. 

 
Mean Safety Factor 
You will notice the mean, standard deviation, min and max values displayed below the 
histogram.  
 
It should be noted that the mean Safety Factor from a Probabilistic Analysis (ie. the average 
of all of the Safety Factors generated by the Probabilistic Analysis) is not always the same as 
the Safety Factor of the Mean Wedge (ie. the Safety Factor of the wedge corresponding to the 
mean Input Data values).  
 
There can be various reasons for this:  
 

1. Monte Carlo sampling does not sample your input data distributions "exactly". 
2. Number of samples is small. 
3. If invalid wedges are generated by the probabilistic analysis (eg. invalid geometries), 

this can also lead to differences between the deterministic safety factor and the 
probabilistic mean safety factor. 

 
NOTE: if you use Latin Hypercube sampling, and a large number of samples eg. (10000), the 
deterministic and probabilistic mean safety factors should be very nearly equal. 
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Plot Cumulative 
To plot a Cumulative Distribution after a Probabilistic Analysis: 
 

1. Select Statistics →→→→ Plot Cumulative or the "Plot Cumulative" toolbar button. 
2. Select a Data Type. 
3. Enter a Number of Intervals. The default is 30, but any value between 1 and 500 can 

be entered. 
4. The display of interval markers may be toggled on or off with the checkbox. 
5. Select OK. 

 
The Cumulative Distribution will be generated, and the mean, standard deviation, minimum 
and maximum values for the data plotted, will be listed at the bottom of the Distribution. 
 
A Cumulative Distribution is, mathematically speaking, the integral of the normalized 
probability density function. Practically speaking, a point on the cumulative distribution 
gives us the probability that a random variable will be LESS THAN OR EQUAL TO a 
specified value. 
 
Simply put, if (X, Y) is a point on the cumulative distribution S-curve, then Y = the 
probability that the random variable will be <= X.  
 
The data Sampler allows the user to obtain the coordinates of points on the S-curve. 
 
The same Data Types, which can be plotted with Plot Histogram, can also be plotted as 
Cumulative Distributions – see the Data Type topic for details. 
 
Several options are available in the right-click menu for Cumulative Distributions, including: 
 
Markers  
Sampler  
Copy Data to Clipboard  
Copy View to Clipboard  
Chart in Excel  
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Plot Scatter 
To create a Scatter Plot after a Probabilistic Analysis: 
 

1. Select Statistics →→→→ Plot Scatter or the "Plot Scatter" toolbar button. 
2. Select the data you would like to plot on the X-axis and Y-axis. 
3. Select OK. 

 
The Scatter Plot will be generated. At the bottom of the Scatter Plot, you will see a listing of 
the Correlation Coefficient, alpha and beta. 
 
Correlation Coefficient 
The Correlation Coefficient indicates the degree of correlation between the two variables 
plotted. The Correlation Coefficient can vary between -1 and 1. Numbers close to zero 
indicate a poor correlation, and numbers close to 1 or -1 indicate a strong correlation. Note 
that a negative correlation coefficient simply means that the slope of the best-fit linear 
regression line is negative. 
 
Alpha and Beta 
Alpha and beta represent the y-intercept and slope, respectively, of the best-fit linear 
regression line to the scatter plot data. The linear regression line can be displayed on the plot 
by selecting the Show Regression Line option. 
 
Several options are available in the right-click menu for Scatter Plots, including: 
 
Show Failed Wedges  
Show Regression Line  
Copy Data to Clipboard  
Copy View to Clipboard  
Chart in Excel  
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Viewing Other Wedges Generated by Analysis 
The following are useful properties of Histograms and Scatter Plots in ROCPLANE: 
 

• If you double-click the LEFT mouse button anywhere on a Histogram or Scatter plot, 
the nearest corresponding wedge from the plot, will be displayed in the 3D Wedge View 
and the 2D Wedge View. 

 
• In addition, all other views of the current document will be updated, to display the 

results for the "Picked" wedge you have selected. For example, the Info Viewer will be 
updated to display the results for the selected wedge. 

 
Here is an example: 
 

1. Generate a Safety Factor Histogram. 
2. Double-click on the histogram at any desired Safety Factor (for example, Safety Factor 

= 1). 
3. Now look at the 3D Wedge view. A new wedge will be displayed, corresponding to the 

point (along the X-axis of the Histogram) at which you clicked. This is an actual wedge 
generated by the Probabilistic analysis. 

4. The Safety Factor of this particular wedge will be displayed in the title bar of the Wedge 
view, and the title bar will now indicate that you are viewing a "Picked" wedge. 

5. Look at the Info Viewer. The Current Wedge Data corresponds to the "Picked" wedge 
you are viewing. 

6. In addition to Safety Factor plots the above applies to Histograms or Scatter plots of 
any Data Type (e.g. Wedge Weight, Input Data variables, etc.). 

 
This feature is meant to give you a general idea of the shape and orientation of wedges 
corresponding to locations on a Histogram or Scatter plot. For example, on a Safety Factor 
Histogram, you will probably want to double-click in the "red" Safety Factor region, to get an 
idea of the wedges that have a Safety Factor < 1. 
 
Resetting the Mean Wedge 
To reset all views so that the mean wedge data is displayed, select Reset Wedge from the 
View menu. This will re-display the wedge corresponding to the mean Probabilistic Input 
Data. 
 
Tip 

Use the Tile option in the Windows menu to tile views, so that you can immediately see the 
"Picked" wedge data displayed when you double-click on a part of a Histogram or Scatter 
plot. 
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Export Dataset 
The Export Dataset option in the Statistics menu allows the user to export raw data from 
a Probabilistic Analysis, to the clipboard, a file, or to Excel. 
 
Data 
All available data from the analysis is initially selected for export (except Wedge Vertex 
Locations). If you do NOT wish to export a given dataset, clear the corresponding checkbox 
before exporting. If a dataset is grayed out, this means that no statistical distribution was 
defined for that dataset. See the Data Type topic for more information about Probabilistic 
Analysis data. 
 
Copy 
Select the Copy button to copy the selected datasets to the Windows clipboard. From the 
clipboard, the data can be pasted into other applications for further analysis or for reporting 
purposes. 
 
Save 
Select the Save button to save the selected datasets to a file. The Save As dialog will allow 
you to save the data in one of 3 different text file formats: 
 

• A tab delimited text file (*.txt) 
• A comma separated values (CSV) text file (*.csv) 
• A space delimited text file (*.prn) 

 
The 3 different formats are all plain ASCII text files, with different methods of delimiting the 
data in each row of the file. 
 
Excel 
Select the Excel button to export the data to Microsoft Excel. If you have the Excel program 
on your computer, Excel will be automatically launched, and the exported data will appear in 
a new Excel document. 
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Tips 

Tabs Option 
The Tabs option in the Window menu, will create tabs at the bottom of the ROCPLANE 
application window, for each view which you currently have open. 
 
If you are working with multiple views or multiple files, then the Tabs option can be useful 
for easily selecting different views, without having to select from the list of views in the 
Window menu. Views can be left maximized within the ROCPLANE application window, and 
you can easily select a view by selecting the corresponding tab. 
 
 

Right-Click Menus 
Various options are available in the right-click menus of the following views: 
 
2D Wedge View  
Histogram Plot  
Cumulative Distribution  
Scatter Plot  
Sensitivity Plot  
Info Viewer  
 
The user will find the right-click menus a useful and timesaving shortcut to many options in 
ROCPLANE.  
 
NOTE that NO right-click menu is available on the 3D Wedge View, since the right mouse 
button is used for moving the wedge out of the slope. 
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